
3901 Barrett Drive Suite 205 Raleigh, NC 27609 
Phone: 919-981-0505 or 800-322-4650  Fax: 919-981-0099 

Web: www.ibraininc.com  Email: Sales@ibraininc.com 

iBrain, Inc. 
 

Intelligent Solutions for your business 

 
 

Accounting Software Solutions 
. . . . . . . . . . . . a division of iBrain, Inc. 

 
 
 
 
 
 
 

E-File W-2 2011 
 

Installation and 
Registration Guide 

 

For Sage Peachtree and QuickBooks 
 
 
 
 
 
 
 

         
 
 
 
 
 

Program design and code Copyright ©2010-2011 iBrain, Inc. 



  Revision U1 

Installation and Registration Guide  Page i 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

This page is intentionally blank. 



  Revision U1 

  Page 1 

Table of Contents 
 

Table of Contents ......................................................................................................................... 1 
Table of Figures ........................................................................................................................... 2 
Initial Documentation Notes: ........................................................................................................ 3 
General Requirements: ................................................................................................................ 3 
Accounting Package Requirements   (Please Read Carefully!!) ................................................. 4 

Program Installation ........................................................................................... 5 
Installing E-File W-2 2011 ............................................................................................................ 6 
Installing Prerequisites ................................................................................................................. 7 

Installing SQL Server 2005 Compact Edition ........................................................................... 7 
Disabling User Access Control (Windows Vista/Windows 7 Only) .......................................... 7 

Installing Adobe Acrobat Reader ................................................................................................. 9 
Uninstalling E-File W-2 2011 ....................................................................................................... 9 

Backing up the Company ................................................................................. 11 
Getting Started ........................................................................................................................... 12 
To make a copy of the Peachtree company: ............................................................................. 12 
To make a copy of the QuickBooks company: .......................................................................... 13 

Product Registration ........................................................................................ 15 
Registering E-File W-2 2011 ...................................................................................................... 16 
Product Registration .................................................................................................................. 16 

Company Selection ........................................................................................... 17 
Adding a Company .................................................................................................................... 18 

Open or Add a Company ........................................................................................................ 18 
Accounting Package ............................................................................................................... 19 
Peachtree Version (Peachtree Only) ..................................................................................... 19 
Select Company (Peachtree) ................................................................................................. 20 
Select Company (QuickBooks) .............................................................................................. 21 
Company Information ............................................................................................................. 22 
Opening a Company .............................................................................................................. 23 

Product Registration ........................................................................................ 25 
Trial Programs ............................................................................................................................ 26 
Product Registration .................................................................................................................. 27 
IBrain, Inc. Support Policy .......................................................................................................... 28 
Feedback ................................................................................................................................... 28 
Notes: ......................................................................................................................................... 28 

 



  Revision U1 

  Page 2 

Table of Figures 
 
Figure 1: User Access Control (Windows Vista) ............................................................................. 7 
Figure 2: User Access Control Window (Windows 7) ...................................................................... 8 
Figure 3: File Information Pane from the Product Information Window ........................................ 13 
Figure 4: Product Registration Information Window ...................................................................... 16 
Figure 5: Company Selection Window .......................................................................................... 18 
Figure 6: Company Selection Window, Accounting Package Step ............................................... 19 
Figure 7: Company Selection Window, Peachtree Version Step .................................................. 19 
Figure 8: Company Selection Window, Company Selection Step (Peachtree) ............................ 20 
Figure 9: Browse for Peachtree Data Path .................................................................................... 20 
Figure 10: Company Selection Window, Company Selection Step (QuickBooks) ........................ 21 
Figure 11: Company Selection Window, Company Info Step ....................................................... 22 
Figure 12: Verify Company Information Dialog ............................................................................. 22 
Figure 13: Company Selection Window, Company Selection Step .............................................. 23 
Figure 14: Trial Notification Window .............................................................................................. 26 
Figure 15: Product Registration Window ....................................................................................... 27 



  Revision U1 

  Page 3 

 

Initial Documentation Notes:  
 

Throughout this text, unless clearly indicated to the contrary, the term “E-File” refers to E-File 
W-2 2011.. 

 

General Requirements: 
• Pentium 1.8 ghz or faster.  A faster processor may be required by your accounting 

package. 
• 1 GB of RAM.  Speed may increase as the amount of memory increases. 
• Hard disk with 60 MB of disk space for installation.  We recommend at least 500 MB 

of free space to be available on the Hard Disk at all times. 
• A graphics card set to an 800x600 screen resolution.  While E-File will work with 

lower screen resolutions, you will have to scroll to see all of some windows. 
• One of the following versions of Microsoft Windows: 

Windows 2000 with Service Pack 4 or greater installed 
Windows XP with Service Pack 3 or greater installed (32 or 64-bit) 
Windows Vista (32 or 64-bit) Service Pack 2 recommended 
Windows 7 (32 or 64-bit) 

• Microsoft .NET Framework v2 must be installed. 
• Microsoft SQL Server Express 2005 must be installed.  This is provided on the CD or 

as a download from our web site at http://www.ibraininc.com.  If you have installed 
any prior version of E-File  this software is already on your computer. 

 
 
Windows 95, 98, 98SE, Windows NT 4, and ME are NOT supported. 
This product will not operate in a Windows Terminal Server Environment using 
Windows Terminal Services. 
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Accounting Package Requirements   
(Please Read Carefully!!) 
 

• One of the following releases of Peachtree: 
 
Peachtree Pro Accounting 2012/2011/2010 
Peachtree Complete Accounting 2012/2011/2010 
Peachtree Premium Accounting 2012/2011/2010 
Peachtree Premium Accounting for Manufacturing 2012/2011/2010 
Peachtree Premium Accounting for Distribution 2012/2011/2010 
Peachtree Premium Accounting for Construction 2012/2011/2010 
Peachtree Premium Accounting for Non-Profit 2012/2011/2010 
Peachtree Quantum 2012/2011/2010 
 
E-File only supports the versions of Peachtree listed above.  If you 
are planning to upgrade to a newer version of Peachtree contact 
iBrain, Inc. at 800-322-4650 before upgrading.  Please note that it 
may take up to 60 days to release a version of E-File compatible with 
the newest release of Peachtree. 
 

• Or one of the following releases of QuickBooks 
 
QuickBooks Pro/Premier 2009-2011 
QuickBooks Enterprise Solutions v9.0-v11.0 

 
• DO NOT attempt to enter or change company data while E-File is retrieving data. 
• You must know the name of the folder in which Peachtree has stored your data and 

where that folder is (the path) on your computer’s hard drive. 
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Program 
Installation 
This section covers installing E-File W-2 2011. 
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Installing E-File W-2 2011 
 

A user who has Windows Administrator rights must install this program. 
Before installing E-File, restart the computer and make sure that all other programs 
are closed.  This means closing Peachtree, as well as toolbars such as those from 
Microsoft Office®. 
 

 
Installing from CD: 
1. Insert the E-File disc into the CD-ROM drive.  If the Install Wizard window does not 

automatically appear: 
• Click on Start, then on Run. 
• Type in X:\Apps\SETUP where the “X” represents the CD-ROM drive letter and click 

OK. 
2. Click on Install “E-File W-2 2011” (3rd Option) from the list of items to start the 

installation. 
3. If the .NET Framework v2 installed, it will be installed now.   
4. Follow the prompts until you get to the End-User License Agreement. 
5. Read the End-User License Agreement.  The continue installation, select I accept the 

terms of the License Agreement and click Next to continue to the next step. 
6. Select which accounting package will be used with this software, QuickBooks or 

Peachtree.  Click Next to continue to the next step. 
7. On the Ready to Install the Program step, examine the current installation settings.  If 

they are correct, click Install to begin the program installation. 
Once the program installation is complete, click Finish. 

 
Installing from a file downloaded from our web site at http://www.ibraininc.com: 
Open the file.  It may ask to run the program. 

1. If the .NET Framework v2 installed, it will be installed now.   
2. Follow the prompts until you get to the End-User License Agreement. 
3. Read the End-User License Agreement.  The continue installation, select I accept the 

terms of the License Agreement and click Next to continue to the next step. 
4. Select which accounting package will be used with this software, QuickBooks or 

Peachtree.  Click Next to continue to the next step. 
5. On the Ready to Install the Program step, examine the current installation settings.  If 

they are correct, click Install to begin the program installation. 
Once the program installation is complete, click Finish. 

 
NOTE: If the .NET Framework v2 is not installed, it will be downloaded and installed. 
An internet connection is required to download the .NET Framework installation files.  
The installation program is approximately 23MB and takes a few minutes to download 
on a broadband (cable, DSL) connection.  On a dial-up connection, it will take at least 1 
hour to download the .NET Framework installation files.  After the .NET Framework 
install is completed, it will prompt to restart the computer. 
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Installing Prerequisites 
 
E-File requires SQL Server 2005 Compact Edition to be installed.  While E-File will install without 
these items installed they must be installed before E-File is started for the first time.  

 

Installing SQL Server 2005 Compact Edition 
 

In order for E-File to be able to open its database SQL Server 2005 Compact Edition 
must be installed.  To do so click Install SQL Server 2005 CE from the Install Wizard 
menu or download and run the installer from one of the following locations: 
 
Microsoft’s web site:  
http://www.microsoft.com/downloads/details.aspx?FamilyID=85e0c3ce-3fa1-453a-8ce9-
af6ca20946c3&DisplayLang=en 
iBrain’s web site: http://www.ibraininc.com/downloads/misc/SSCERuntime-ENU.msi 
 
Administrative rights are required in order to install the program.   
 

Disabling User Access Control (Windows Vista/Windows 
7 Only) 
 

User Access Control (UAC) was added to Windows Vista and Windows 7 to decrease the 
chance of malware or viruses infecting your computer.  However Microsoft SQL Server 
2005 Compact Edition requires UAC to be disabled in order to install properly.  The UAC 
Settings can be changed back when the installation is complete. 
 
To disable UAC: 

1. Click the Start button and select Control Panel. 
2. Under Vista: 

• Click User Accounts and Family Safety then User Accounts (standard 
view) or User Accounts (Classic View). 

• Click Turn User Access Control on or off. 
• Click OK.  A dialog will appear asking to restart the system. 

 

 
Figure 1: User Access Control (Windows Vista) 

3. Under Windows 7: 
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• Click User Accounts, then User Accounts again. 
• Click Change User Account Control settings. 
• On the User Account Control settings, slide the bar from Default to Never 

Notify 
• Click OK.  A dialog will appear asking to restart the system. 

 
 

 
Figure 2: User Access Control Window (Windows 7) 
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Installing Adobe Acrobat Reader 
 

Documentation for E-File is installed with the program.  To view these files, Adobe 
Acrobat Reader must  be installed. 
 
To install Adobe Acrobat Reader, click on the Install Acrobat Reader item from the 
Install Wizard window and follow the prompts. 

 

Uninstalling E-File W-2 2011 
 

To uninstall E-File, go to Add/Remove Programs and select E-File W-2 2011 from the list 
of programs.  Please note that any data files made by E-File are not removed since they 
are stored in a separate location. 
 
To remove the data for E-File, it is stored in the following locations: 
 
Windows 2000, XP:  
C:\Documents and Settings\All Users\Application Data\Accounting Software Solutions\E-
File W-2 2011 
 
Windows Vista, Windows 7: 
C:\ProgramData\Accounting Software Solutions\E-File W-2 2011 
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Backing up 
the Company 

 
Topics covered in this section: 

• Backing up the company 

2 
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Getting Started 
 

Before installing and registering E-File, we recommend that the company data be copied 
to a separate location and name the company file or folder something that will be easy to 
remember, like PR2011.  In E-File, the copy of the company should be used instead of 
the original.  The reason for this is threefold: 
1. It copies the company to another directory, so any changes made to the copy don’t 

affect the original. 
2. It allows other users to access the real company while data is retrieving from the 

company.  When E-File is retrieving information, it is recommended that no one else 
use that company. 

3. According to the EFW2 (Social Security Administration) specifications, the report 
needs to be creatable for up to 4 years.  E-File can only retrieve data for the 2011 
payroll year.  By making a copy of the company, the ability reproduce the report with 
the correct data is assured. 

 

To make a copy of the Peachtree 
company: 

Determine the company directory name. 
1. Open the company in Peachtree. 
2. From the Help main screen menu, select Customer Support and Service and File 

Statistics.  
3. The company directory name will be in the title bar of the File Statistics Window. 
4. Open Windows Explorer by pressing the Windows logo key on the keyboard and 

the letter E. 
5. Go to the drive and directory where the company data is stored.  As an example, if 

the DATAPATH is ‘C:\PEACHW’, then click Drive C, then the PEACHW directory. 
6. Select the Peachtree company folder specified in Step 1. 
7. From the Edit pull-down menu, select Copy. 
8. Navigate to the drive location where the company folder will be copied. 
9. From the Edit menu, select Paste.  If the folder was copied to the DATAPATH folder, 

this will place a folder called Copy of XXXX, where the XXXX is the name of the 
original company folder.  

10. Select the copy of the folder. 
11. Click on the File menu, then on Rename. 
12. Give the folder a meaningful name that is 8 characters or less without spaces and 

press enter.  Companies running E-File with more than one Peachtree company may 
want to use a folder name similar to PR11xxxx, where xxxx is a four letter Company 
ID. 

13. Open the copy of the company in Peachtree.  If the folder was copied outside of the 
DATAPATH, the location of the company folder will have to be specified before the 
company name can be selected. 

14. Note that there will be two companies with the same or similar names: the original 
and the copy.  To make sure that the company that is opened is the copy, follow step 
1.  If it is the original company, open the other instance of the company. 

15. Once it is certain that the open company is the copy that was made earlier, change 
the company name by clicking the Maintain main screen menu and selecting 
Company Information.  Give it a meaningful name, like W-2 Company 2011.  When 
the company is selected in E-File, the company name can be changed to the actual 
name of the company. 
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To make a copy of the QuickBooks 
company: 

1. Determine your company file name. This is done by pressing the Control (Ctrl) and 1 
keys. The Product Information window will appear with information related to the 
current open company. The File Information pane contains the location of the 
currently open company (Figure 3). Write this location down.  

 

 
Figure 3: File Information Pane from the Product Information Window 

 
2. Open Windows Explorer. It is located under Start, Programs, Accessories, and 

Windows Explorer.  
3. Go to the drive and directory listed in Step 1.  
4. Select the QuickBooks company file specified in Step 1.  
5. Click on the Edit menu, then on Copy.  
6. Select where the company file will be copied  
7. Click on the Edit menu, then on Paste. If the file was copied to the same location as 

the original company file, this will place a file called ‘Copy of XXXX’, where the 
‘XXXX’ is the name of the original company file. Otherwise the file will have the same 
name as the original company file.  

8. Select the copy of the file.  
9. Click on the File menu, then on Rename.  
10. Give the company file a meaningful name and press enter. Companies running E-File 

with more than one QuickBooks company may want to use a file name similar to 
‘PR11xxxx’, where ‘xxxx’ is a four letter Company ID.  

11. Open the copy of the company in QuickBooks.  
12. Once it is certain that the open company is the copy that was made earlier, change 

the company name by clicking on Company, then on Company Information. Give it 
a meaningful name, like W-2 Payroll 2011. When the company is selected in E-

File, the company name can be changed to the actual name of the company.  
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Product 
Registration 
 
Topics covered in this section: 
 

• E-File W-2 2011 Product Registration 
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Registering E-File W-2 2011 
 

To start the program, double-click on the icon that was installed on the desktop by the 
installation program, or select the program from your Start menu. 
 

Product Registration 
 
The first step in the product registration process is to enter product registration 
information in the window shown in Figure 4. The following fields are required on the 
registration form: 
• Company Name 
• Address 1 
• City, State, Zip Code 
 
Once the data is entered and double-checked, click OK to continue.  
 

 
Figure 4: Product Registration Information Window 
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Company 
Selection 
Topics covered in this section: 

• Adding a company to E-File W-2 2011 
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Adding a Company 
 
NOTE: The procedure to add a company has been completely rewritten. 
 

Open or Add a Company 
 
If a company has not yet been selected, the Company Selection Window will be shown in 
Figure 5 below. The left side of the window contains the steps along with the total number of 
companies and the number of companies that can be added.   As you progress through the 
steps, the step that you are currently on will be highlighted. 

 

 
Figure 5: Company Selection Window 

The first time this screen is accessed, Open a Company will be disabled.  Select Add a 
Company and click Next to proceed to the next step. 
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Accounting Package 

 
Figure 6: Company Selection Window, Accounting Package Step 

Here the accounting package used with the company can be selected.  Select Peachtree or 
QuickBooks and click Next to continue. 

Peachtree Version (Peachtree Only) 

 
Figure 7: Company Selection Window, Peachtree Version Step 

The version of Peachtree must be selected.  Select Peachtree 2010, Peachtree 2011 or 
Peachtree 2012 and click Next to proceed. 
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Select Company (Peachtree) 
 

 
Figure 8: Company Selection Window, Company Selection Step (Peachtree) 

 
Once a version of Peachtree is selected, E-File will list all valid companies in Peachtree’s data 
path.  If the company is not in the data path, click Browse… to locate the folder that contains the 
company folder.  Sample Peachtree companies are not shown in the list. 
 
 

 
Figure 9: Browse for Peachtree Data Path 
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Select Company (QuickBooks) 
The company selection for Quickbooks is done differently than for Peachtree.  Instead of showing 
all companies for a specified path, the company file must be selected. 
 
 

 
Figure 10: Company Selection Window, Company Selection Step (QuickBooks) 

 
Before starting, make sure that the QuickBooks company file is not open by any user. 
 
 
Click Browse… and locate the QuickBooks company file.  If the company file’s location is not 
known, open the file in QuickBooks and press Control (Ctrl) and 1 to open the File Information 
window. 
 
Once the file has been selected, open the company in QuickBooks and log in as Admin, then 
click Next to retrieve company information. 
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Company Information 
 

 
Figure 11: Company Selection Window, Company Info Step 

 
Once the company has been selected, E-File will retrieve and display the company information 
from the accounting software.  If the company information needs to be changed, edit the 
information.  Once the company information is acceptable click Next to continue.  The company 
information will need to be confirmed. 
 

 
Figure 12: Verify Company Information Dialog 

 
Once the company information has been verified against the information in the accounting 
package, the Company Selection step will be shown. 
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Opening a Company 
 

 
Figure 13: Company Selection Window, Company Selection Step 

 
Once on the Company Selection step, click the company to open and click OK to open the 
company. 



  Revision U1 

Installation and Registration Guide  Page 24 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page is intentionally blank. 



  Revision U1 

  Page 25  Pag

 

Product 
Registration  
 
Topics covered in this section: 
 

• Trial Programs 
• E-File W-2 2011 Product Registration 
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Trial Programs 
 

E-File installs as a 15-day trial.  The program will perform the same as if it were 
registered, with the exceptions that each time the program starts, a trial notification 
window will appear and that report files will not be created.  This is done to allow 
customers to try out the program before purchasing the product. 
 

 
Figure 14: Trial Notification Window 
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Product Registration 
Once the program has been purchased, the program can be registered by clicking 
Register via Phone from the Trial Notification window, or by selecting Help, Register 
and finally Register via Phone from the main window. 

 

 
Figure 15: Product Registration Window 

 
Call iBrain, Inc. at 800-322-3650 or 919-981-0505 between 9:00 and 6:00 Eastern Time to obtain 
a license code and/or password. 
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IBrain, Inc. Support Policy 
 

iBrian, Inc. warrants that this program will perform as set forth herein.   If the program fails to so 
perform, in addition to the obligations of iBrian, Inc. as set forth in the License Agreement, iBrian, 
Inc. will furnish telephone technical support at no cost to the licensee.  In the event performance 
problems result from data errors of the licensee or failure by the licensee to follow the instructions 
contained herein or for any other reason except those set forth in the opening sentence of this 
paragraph, iBrian, Inc. will furnish telephone technical support but will charge the licensee for 
telephone technical support time at iBrian, Inc.’s published telephone technical support rates, 
which are available upon request.  Licensees are required to furnish iBrian, Inc. with credit card 
information prior to the beginning of any support call, which credit card information is deemed to be 
confidential.  Licensees will be informed as soon as feasible whether a given support call will result 
in charges being billed to the licensee’s credit card.  The licensee may terminate the support call at 
will. 
 

 
 

Feedback 
 

If you would like to send any comments about this program to iBrain, you can contact us at  
 

Accounting Software Solutions 
A division of iBrain, Inc. 
3901 Barrett Drive 
Suite 205 
Raleigh, NC 27609 

 
Phone:   (919) 981-0505 or 

(800) 322-4650 
Fax:  (919) 981-0099 
Email:  support@ibraininc.com  

 Web site:  www.ibraininc.com  
 

Notes:  
 

   “Peachtree” when used herein as an entity refers to Sage, Inc., which is the sole owner 
of all copyrights and trademarks to its programs referred to herein. 
   “QuickBooks” when used herein as an entity refers to Intuit, Inc., which is the sole owner 
of all copyrights and trademarks to its programs referred to herein. 
     “Windows” when used herein refers to Microsoft Windows, a registered trademark of 
Microsoft Corporation. 
   “iBrain” when used herein, other than as part of a program name, refers to iBrain, Inc., 
which is the sole owner of all copyrights and trademarks to its programs referred to above. 
  “Acrobat ® Reader” Copyright © 1987-2011 Adobe Systems Incorporated. All rights 
reserved. Adobe, the Adobe logo, Acrobat, and the Acrobat logo are trademarks of Adobe 
Systems Incorporated. 
   All screen shots included herein are taken either from material published by Sage 
Software North America or from material produced by iBrain, Inc. and none are relevant to 
any real entity.  

 


